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If you have an earlier model Newton PDA, such as an Apple
MessagePad 100, or MessagePad 110, follow these
instructions to transfer information to your new Newton
PDA.

Warning

Information transferred from an earlier model Newton PDA
replaces similar information on your new Newton PDA.
Make sure you read these instructions carefully.

How to transfer

If you have the Newton Backup Utility for the Mac OS, follow
the instructions in the section “Macintosh Users.” If you
have the Newton Backup Utility for Windows, follow the
instructions in the section “Windows Users.”

You should use the Newton Backup Utility instead of a
storage card to transfer information from your earlier model
Newton PDA. If you can’t use the Newton Backup Utility (for
example, if you don’t have a computer), follow the
instructions in the section “Using a Storage Card.” 

If you have additional questions about transferring
information from your earlier model Newton PDA to your
new Newton PDA, please call 1-800-SOS-APPL (U.S.
customers only) or contact your local Apple authorized
dealer.

Compatibility notice

Your new Newton PDA uses the Newton 2.0 operating
system. Some of the applications and application
information on your earlier model Newton PDA may not
work with the new operating system. Contact the Newton
software publisher for more information. 
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If you’ve used Newton Connection 2.0 or 1.0

Files created with Newton Connection 2.0 or 1.0 are not
recognized by the Newton 2.0 operating system. Instead, use
the Newton Backup Utility to transfer information from an
earlier model Newton PDA to your new Newton PDA.

Overview

The following illustration shows the steps you take if you
use the Newton Backup Utility to transfer information.
These steps are described in detail below.

1. Back up your new Newton PDA.

2. Rename your Backups folder.  

 3. Back up your earlier model Newton PDA.

4. Restore backup files from your earlier model
    Newton PDA to your new Newton PDA.



Macintosh users

To back up and transfer information, you’ll need the
following:

m the Newton Backup Utility disks

m a serial cable or an AppleTalk connection kit (to connect
your Newton PDA to your computer). A serial cable is
included with your new Newton PDA.

m a Mac OS–based computer with a 68030 or higher
processor, using system software version 7.0 or later

Backing up your new Newton PDA

Before you transfer information from an earlier model
Newton PDA, back up information on your new Newton
PDA. That way, you’ll have a backup of the preinstalled
packages that ship with your new Newton PDA.

1 Insert the Install 1 disk for the Newton Backup Utility into
your computer.

2 Open the Install 1 disk icon and double-click the Install
Newton Backup Utility icon.

Follow the installation instructions on the screen. When
installation is complete, a Newton Backup Utility folder
appears on your computer.

3 Connect your new Newton PDA to your computer.

Use a serial cable or an AppleTalk connection kit. For more
information, see the Newton Backup Utility User’s Guide.
This is an online manual located in the Newton Backup
Utility folder.
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4 On your computer, open the Newton Backup Utility folder
and double-click the Newton Backup Utility icon.

The Newton Backup Utility window appears on your
computer.

5 Choose Preferences from the Edit menu and make sure the
type of connection you made is selected.

6 Turn on your new Newton PDA.

Follow the setup instructions on the screen.

7 Tap Extras ´ to open the Extras Drawer, then tap
Connection k.

8 Tap “Connect via” and choose the type of connection you
made; then tap Connect.

9 On your computer, click the Backup button in the Newton
Backup Utility window.

When the backup is complete, a Backups folder appears in
the Newton Backup Utility folder. This folder contains the
backup file for your new Newton PDA.

10 Change the name of the folder to “2.0 Backups.”

11 Turn off your new Newton PDA and disconnect it from your
computer.

Backing up your earlier model Newton PDA

1 Connect your earlier model Newton PDA to your computer.

2 Turn on your earlier model Newton PDA.

3 On your Newton PDA, tap Extras ´ to open the Extras
Drawer, then tap Connection k.
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4 Choose the type of connection you made and tap Connect.

When you establish a connection from your earlier model
Newton PDA, a backup begins automatically.

When the backup is complete, a Backups folder appears in
the Newton Backup Utility folder. This folder contains the
backup file for your earlier model Newton PDA.

5 Turn off your earlier model Newton PDA and disconnect it
from your computer.

Restoring the backup file

1 Reconnect your new Newton PDA to your computer.

2 Turn on your new Newton PDA.

3 On your Newton PDA, tap Extras ´ to open the Extras
Drawer, then tap Connection k.

4 Tap Connect.

5 On your computer, click the Restore button in the Newton
Backup Utility window.

A dialog box appears with a list of files to restore.

6 Select the backup file you just created for your earlier model
Newton PDA.

Make sure you don’t select a file in the 2.0 Backups folder by
mistake.

7 Click Open.

A dialog box appears with a list of information and packages
to restore. 
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8 Select the items you want to restore.

You should restore information (such as Names, Dates, and
Notepad), but not packages. You can restore packages later
after you’ve verified which ones are compatible with your
new Newton PDA.

Important  Do not restore packages or information that is
incompatible with the Newton 2.0 operating system. Contact
the Newton software publisher to see if your packages are
compatible. If you restore an incompatible package by
mistake, it won’t harm your Newton PDA.

9 Click Restore.

After a few minutes, a message appears on your Newton
screen asking you to restart.

10 Tap Restart.

After a few moments, your Newton PDA restarts and the
setup instructions appear on the screen.

Congratulations! You’ve successfully transferred information
from your earlier model Newton PDA. See “Cleaning Up
Transferred Information” later in this booklet.

Windows users

To back up information and packages, you’ll need the
following:

m the Newton Backup Utility disks

m a serial cable (to connect your Newton PDA to your
computer). A serial cable is included with your new Newton
PDA.
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m a PC-compatible computer with a 80386 or higher processor,
using Windows 3.1 or later, Windows NT 3.5 or later, or
Windows 95

m an available serial port

Backing up your new Newton PDA

Before you transfer information from an earlier model
Newton PDA, back up information on your new Newton
PDA. That way, you’ll have a backup of the preinstalled
packages that ship with your new Newton PDA.

1 On your computer, start Windows and insert the Setup 1
disk for the Newton Backup Utility into a floppy disk drive.

2 From the Program Manager, choose Run from the File menu.

Note:  If you’re using Windows 95, choose Run from the
Start menu.

3 Type A:\SETUP and click OK.

If you’re using the B drive, type B:\SETUP instead.

4 Follow the installation instructions on the screen. 

By default, the Newton Backup Utility is installed in the
Newton Backup Utility directory. You can choose the name
and location of this directory.

5 If necessary, restart your computer.

6 Connect your new Newton PDA to your computer.

Use a serial cable. For more information, see the Newton
Backup Utility User’s Guide. This is an online manual
(MANUAL.PDF) located in the Newton Backup Utility
directory.
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7 On your computer, double-click the Newton Backup Utility
icon to open it.

The Newton Backup Utility window appears on your
computer.

8 Choose Settings from the Newton menu.

9 Click the Communications tab in the window.

The communications options appear.

10 Select the port you used to connect the serial cable and click
OK.

11 Turn on your Newton PDA.

Follow the setup instructions on the screen.

12 On your Newton PDA, tap Extras ´ to open the Extras
Drawer, then tap Connection k.

13 Tap “Connect via” and choose Serial; then tap Connect.

Note:  On some Windows computers, you may need to
choose “Serial 9600–Windows” instead of Serial. See “About
Windows Connections” later in this booklet for more
information.

14 On your computer, click the Backup button in the Newton
Backup Utility window.

When the backup is complete, a BACKUPS directory appears
in the Newton Backup Utility directory. This directory
contains the backup file for your Newton PDA.

15 Rename the directory BACKUPS.20.

16 Turn off your new Newton PDA and disconnect it from your
computer.
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Backing up your earlier model Newton PDA

1 Connect your earlier model Newton PDA to your computer.

2 Turn on your earlier model Newton PDA.

3 On your Newton PDA, tap Extras ´ to open the Extras
Drawer, then tap Connection k.

4 Choose the correct connection type and tap Connect.

Important  Choose “Macintosh serial” or “DOS or
Windows 9600 serial.” Even though you’re connecting to a
Windows PC, do not choose “DOS or Windows PC.” For
more information, see “About Windows Connections” later
in this booklet.

When you establish a connection from your earlier model
Newton PDA, a backup begins automatically.

When the backup is complete, a BACKUPS directory appears
in the Newton Backup Utility directory. This directory
contains the backup file for your earlier model Newton PDA.

5 Turn off your earlier model Newton PDA and disconnect it
from your computer.

Restoring the backup file

1 Reconnect your new Newton PDA to your computer.

2 Turn on your new Newton PDA.

3 On your Newton PDA, tap Extras ´ to open the Extras
Drawer, then tap Connection k.

4 Tap Connect.



5 On your computer, click the Restore button in the Newton
Backup Utility window.

A window appears with a list of files to restore.

6 Select the backup file you just created for your earlier model
Newton PDA.

Make sure you don’t select a file in the BACKUPS.20
directory by mistake.

7 Click OK.

A window appears with a list of information and packages to
restore. 

8 Select the items you want to restore.

You should restore information, (such as Names, Dates, and
Notepad), but not packages. You can restore packages later
after you’ve verified which ones are compatible with your
new Newton PDA.

Important  Do not restore packages or information that is
incompatible with the Newton 2.0 operating system. Contact
the Newton software publisher to see if your packages are
compatible. If you restore an incompatible package by
mistake, it won’t harm your Newton PDA.

9 Click Restore.

After a few minutes, message appears on your Newton
screen asking you to restart.

10 Tap Restart.

After a few moments, your Newton PDA restarts and the
setup instructions appear on the screen.

Congratulations! You’ve successfully transferred information
from your earlier model Newton PDA. See “Cleaning Up
Transferred Information” later in this booklet.
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About Windows connections

The Newton Backup Utility supports both a high-speed
(38,400 baud) and a standard-speed (9600 baud) connection
for your Newton PDA.

If your computer doesn’t support a high-speed connection
(for example, if a communications error message appears
when you use the Newton Backup Utility), use the standard-
speed connection.

To use a standard-speed connection:

m On your computer, open the Settings window in the Newton
Backup Utility and select a connection speed of 9600.

m On your new Newton PDA, choose “Serial 9600–Windows”
instead of “Serial” for your connection type.

m On a Newton PDA that uses an earlier version of the Newton
operating system, choose “DOS or Windows 9600 serial” for
your connection type. 

Important  For Newton PDAs that use an earlier version of
the Newton operating system, you’ll need to install a system
update that includes this connection type. See “Installing the
System Update” below for more information. Do not install
the system update on your new Newton PDA.

Installing the system update

The system update for your earlier model Newton PDA is
contained in a compressed file (SYSUPDT.EXE). This file is
included on your Newton Backup Utility disks.

To install the system update:

1 Copy the compressed file (SYSUPDT.EXE) to your hard disk.
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2 Open the File Manager and double-click the SYSUPDT.EXE
file.

The file expands to the following:

m The Newton Package Installer (NEWTINST.EXE). You use the
Newton Package Installer to install the system update on
your Newton PDA.

m Package files that contain system updates for a Newton
MessagePad 100, 110 or 120 (MP100.PKG, MP110.PKG,
MP120.PKG, MPZ120.PKG). You install the appropriate
system update for your model Newton PDA. 

Note:  Use the MPZ120.PKG system update if you have an
international MessagePad 120.

3 Connect your Newton PDA to your computer.

Important  Make sure your Newton PDA is turned off
before you connect your Newton PDA to your computer.

4 Turn on your Newton PDA.

5 In the Program Manager, choose Run from the File menu
and open the Newton Package Installer (NEWTINST.EXE).

Note:  If you’re using Windows 95, choose Run from the
Start menu.

The Newton Package Installer window appears.

6 Choose Preferences from the Edit menu.

7 Select the port you used to connect your Newton PDA to
your computer and click OK.

8 Choose Install Package from the File menu.

The Install Package window appears.
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9 Select the system update that’s appropriate for your model
Newton PDA and click OK.

10 On your Newton PDA, tap Extras ´ to open the Extras
Drawer, then tap Connection k.

11 Choose “DOS or Windows PC” as your type of connection
and tap Connect.

After a few moments, the system update is installed on your
Newton PDA and a message appears asking you to restart.

12 Restart your Newton PDA.

13 Tap Extras ´ to open the Extras Drawer, then tap
Connection k.

You should see a new connection type, “DOS or Windows
9600 serial.”

Using a storage card

You should use the Newton Backup Utility instead of a
storage card to transfer information from your earlier model
Newton PDA. If you can’t use the Newton Backup Utility (for
example, if you don’t have a computer), follow the
instructions in this section.

You’ll need two storage cards: one card (formatted for the
Newton 2.0 operating system) to back up information on
your new Newton PDA, and one card (formatted for an
earlier version of the Newton operating system) to transfer
information from your earlier model Newton PDA. 
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Backing up your new Newton PDA

Before you transfer information from your earlier model
Newton PDA, back up information on your new Newton
PDA. That way, you’ll have a backup of the preinstalled
packages that ship with your new Newton PDA.

1 Turn on your new Newton PDA.

Follow the setup instructions on the screen.

2 Insert a storage card into your new Newton PDA.

Make sure you push the card all the way into its slot and lock
the locking tab on your Newton PDA.

3 If necessary, format the storage card for use with the Newton
2.0 operating system.

For more information, see the handbook that came with
your new Newton PDA.

Warning  Formatting a storage card erases all information
on the card.

When formatting is complete, a card slip appears.

4 Tap Backup.

A slip appears with a list of items to back up.

5 Make sure all information and packages are selected.

6 Tap Backup.

Your Newton PDA backs up all information and packages to
the storage card.
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7 When the backup is complete, tap X to close the card slip.

8 Unlock the card slot and push the release lever to release
the storage card.

9 Set the storage card aside for safekeeping.

Backing up your earlier model Newton PDA

1 Turn on your earlier model Newton PDA.

2 Insert a storage card into your earlier model Newton PDA.

Important  Do not insert the storage card you used to
back up your new Newton PDA. That storage card is
unreadable on your earlier model Newton PDA.

3 When the card slip appears, tap Backup.

Your Newton PDA backs up all information and packages
onto the storage card.

4 When the backup is complete, tap X to close the card slip.

5 Remove the storage card and turn off your earlier model
Newton PDA.

Restoring the backup file

1 If necessary, turn on your new Newton PDA.

2 Insert the storage card you just used to back up your earlier
model Newton PDA.

Make sure you don’t insert the storage card you used to
back up your new Newton PDA.

A slip appears stating that the card you’ve inserted was
formatted with an earlier version of system software.
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3 Tap “Mount read-only.”

A card slip appears.

4 Tap Restore.

A slip appears with a list of information and packages to
restore.

5 Select the items you want to restore. 

Apple recommends you restore information (such as Names,
Dates, and Notepad), but not packages. You can restore
packages later after you’ve verified which ones are
compatible with your new Newton PDA.

Important  Do not restore packages or information that is
incompatible with the Newton 2.0 operating system. Contact
the Newton software publisher to see if your packages are
compatible. If you restore an incompatible package by
mistake, it won’t harm your Newton PDA.

6 Tap Restore.

After a few minutes, a message appears asking you to restart.

7 Take the storage card out of your Newton PDA and tap
Restart.

After a few moments, your Newton PDA restarts and the
setup instructions appear on the screen.

Congratulations! You’ve successfully transferred information
from your earlier model Newton PDA. See “Cleaning Up
Transferred Information,” next.
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Cleaning up transferred information

When you transfer information from your earlier model
Newton PDA to your new Newton PDA, you may need to
clean up some of the owner information you entered to
personalize your Newton PDA.

For example, on your new Newton PDA, your first and last
names are stored as two separate items in the Owner Info
slip. On your earlier model Newton PDA, your first and last
names are stored as one item. 

When you transfer the information to your new Newton
PDA, your first and last names appear in the First Name area
of the Owner Info slip. You’ll need to select the last name
and move it to the Last Name area of the slip. The same is
true for other types of information, such as your city, state,
and zip code.

See the handbook that came with your new Newton PDA for
information on selecting and moving text.

For more information

For more information on using the Newton Backup Utility,
see the Newton Backup Utility User’s Guide. This user’s
guide is included on the Newton Backup Utility disks.

For more information on using storage cards to back up and
restore information on your Newton PDA, see the handbook
that came with your Newton PDA.
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